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EMC Standard, EN 61326-1: 2006, Electrical Equipment for Measurement, Control and 
Laboratory Use.

	 Emissions Class A, Commercial Equipment.
	 Immunity Table 2, Industrial Equipment.
LVD Standards, EN 61010-1: 2010, Safety Requirements for Electrical Equipment for 

Measurement, Control and Laboratory Use and; 
	 EN 61010-2-030: Particular Requirements for Testing and Measuring Circuits.
smarty is an industrial controller designed for permanent installation by qualified professionals. 

If  it is used in a manner not specified herein the protection provided may be impaired.
smarty and its packaging contain recyclable materials and a small rechargeable battery, classed 

as “portable”, that is permanently affixed to the underside of the main circuit board. Items 
must be separated for proper disposal. The battery may be removed with wire-cutting pliers.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two 
conditions: (1)This device may not cause harmful interference, and (2)this device must accept 
any interference received, including interference that may cause undesired operation.

This Class [A] digital apparatus complies with Canadian ICES-003.  Cet appareil numerique de la 
classe [A] est conforme à la norme NMB-003 du Canada.

Warning! It is essential that you read and understand this entire manual and the entire 
contents of the savvy software Help menu before proceeding with your installation and 
configuration. See page 9 for savvy installation instructions. For more information and to 
download manuals and software, go to www.driveweb.com or contact us. See page 24.

Warning! Your use of savvy software and drive.web devices may cause motors and 
machinery to power up with high Voltages or start or operate in an unexpected, dangerous or lethal 
way. It is essential that you are completely familiar with all of the equipment and the system design 
before attempting to program or edit a program or connect to any live device. It is also essential that 
a risk assessment is conducted to identify hazards. Risks must be reduced to tolerable levels.

Warning! You are entirely responsible for the configuration or use of any drive.web product. 
By configuring or using these products you agree to indemnify and hold harmless Bardac 
Corporation, its’ employees, directors, officers, distributors and resellers against the consequences of 
your configuration or use of  the products.

Warning! Information in this manual is subject to change without notice. You are responsible 
for verifying the proper operation of your smarty module. Special care must be taken after loading 
new firmware or installing new options.

Warning! Avoid permanent damage to your smarty, never exceed any min or max values.  
Do not connect any smarty terminal to mains circuits. See page 8 for IO ratings.
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  Conformity Statements:

lwIP is incorporated into smarty firmware. lwIP Copyright (c) 2001-2004 Swedish Institute of  Computer Science. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
1. Redistributions of  source code must retain the above copyright notice, this list of  conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the 
documentation and/or other materials provided with the distribution.
3. The name of  the author may not be used to endorse or promote products derived from this software without specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE AUTHOR ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.
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Product Identification smarty-o Model dw213
smarty is a range of programmable devices using drive.web distributed 
control over Ethernet for industrial process automation. To program and use 
a smarty you must get the savvy software tools from www.driveweb.com. 
Please see pages 9 to 12. 
To find the smarty‘s firmware version, launch savvy, choose Get Detailed 
Info from the smarty contextual menu. See pages 11, 12. 

smarty-o Standard Features
drive.web distributed process control.
Optidrive Plus serial link and function blocks
10/100Base-T(X) Ethernet, pages 5 - 7
Field upgradeable firmware
8 flexible I/O: ±10V 16-bit analog in, ±10V 14-bit analog out, digital. in. 
8 flexible I/O: 0-10V 16-bit analog in, 24V digital out, digital in. Page 8.
Plug-in Terminal Blocks. 
Compact DIN rail enclosure, pages 5-7.
±10V Control Reference Outputs, 20mA max. See page 7 and 8. 
Four +24V & Four 0V terminals for power & control reference, page 5, 8.
Real Time/Date Clock with SNTP network time server synchronization.
E-Mail Notify block, outgoing SMTP mail server support, page 11.
Basic Control Function Block Library.

smarty Software Options 
Software options may be added using savvy. See page 13. See savvy User 
Manual, Appendix A for up-to-date function block listings.
04 ModbusTCP/IP Slave/Server. See pages 19, 20, 22.
05 Process Control. Function Block Library 1.
06 Winder Control. Function Block Library 2.  See page 18.
10 Advanced Math. Function Block Library 3. 
11 Encoder Control. Function Block Library 4. Requires encoder hardware
25 EIP/PCCC Slave/Server. See page 19, 20, 23.
26 savvyPanel Operator Station Interface. See pages 14 to 17.
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smarty-o Internal Hardware Options 14-17
Factory installed. Contact us for availability.   16,17 are mutually exclusive.
14 Power over Ethernet (PoE) See page 19 & separate manual HG502612.
16* External Encoder Module i2i Receiver Port. See page 19. 
17* ModbusRTU Slave (RS485) isolated port. See pages 19, 20, 22.

smarty-o External Options see pages 23 and 24
40 & 42 mutually exclusive. 45 & 46 mutually exclusive & require 40 or 42
30 115V Digital Input, Relay Output Isolator . See manual HG502622.
31 230V Digital Input, Relay Output Isolator . See manual HG502622.
40 Single Incremental Encoder Module 2V to 24V differential with marker.

5VDC, 200mA encoder supply output,  Two 24V logic event inputs.
42 Dual Incremental Encoder Module 2V to 24V differential with markers. 

Two 5VDC, 200mA enc. supply outputs,  Two 24V logic event inputs.
45 Encoder Retransmit EIA(RS)485 & 422 compliant.
46 Encoder Retransmit ±24V differential signal out.

smarty-o Specials
Generic engineered solutions include required options (in parentheses), 
system configuration and wiring diagram. Contact us for other engineered 
solutions. All options may be added. 
dw213-1101 Open-loop Constant Tension Center Winder (05, 06)
dw213-1102 Closed-loop Dancer Control Center Winder (05, 06)
dw213-1103 Closed-loop Loadcell Control Center Winder (05, 06)
dw213-1104 Slip Core Winder (05, 06)
dw213-1105 Electronic Line Shaft, Speed Lock (05, 11, 16, 42 & 45 or 46)
dw213-1106 Coordinated Drive, Line Master Controller (05)
dw213-1107 Analog Drive Front-End Upgrade (05)
dw213-1108 Electronic Line Shaft, Phase Lock (05, 11, 16, 42 & 45 or 46)
dw213-1109 Electronic Line Shaft, Registration (05, 11, 16, 42 & 45 or 46)
dw213-1110 3 PID Controller w/ integral reset & hold (05)

drive.web automation

smarty-o HG502575Iss1.2
  www.driveweb.com !            Page 4/24

*

http://www.driveweb.com
http://www.driveweb.com


smarty-o Installation
smarty-o is designed for permanent installation by qualified professionals.
Dimensions & Clearances:
Clearances must be provided to promote airflow. Lesser clearances may be 
possible. Ensure the Temperature parameter in the System function block 
does not exceed 70℃. Forced air circulation may be required. See 
Environment, next page.

Weight: No hardware opts.-176g(6.2oz). W/ PoE & Serial Ports-213g(7.5oz)
DIN Rail Mounting. Use 35x7.5mm rail per IEC 60715 or EN50022.
Power Requirements: Regulated 24VDC ±10%, 100mA plus loads.  Do 
not connect to a distributed DC power network. External 1A fast-acting 
fuse or current limiting is required! 
Environment: UL/IEC Pollution Degree 2, Operating temperature, 0°C 
min., 50°C max. Altitude 3000m max. Storage temp, -20°C to 60°C. Humidity 
95% max. non-condensing. Install in metal enclosure with no RF noise source
Ethernet Port MDI 8P8C, “RJ45” jack, 100baseTX and 10BaseT, Full 
Duplex, Auto Negotiation, Auto-MDIX, IEEE 802.3ab. 
USB Port,Currently not used. Support is planned, please call for information

Terminal Wiring: Strip 7mm(0.28”) or use ferrules. Use 0.2mm2 (AWG24) 
minimum. One wire, 2.5mm2 (AWG12) maximum.  Two wires, 1.5mm2

(AWG14) maximum. Two wires with ferrules, 1mm2 (AWG18) maximum.
Terminal Tightening Torque: 0.5 Nm (4.4 in⋄lbs)
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Depth120㎜	 
[4.72”]

Top & Bottom 
Clearances 

51㎜ (2”)

Width 23㎜
[0.91”]

Height 
104㎜
[4.09”]

 Sides Clearances
25㎜ (1”)
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smarty-o Installation continued...

smarty-o to Optidrive Plus Serial Link assembly LA502803 is provided. 

Warning! Only qualified persons should connect this 
cable! Dangerous Voltages and/or motor activation 
causing injury, death and property damage may 
result! You must read and understand the entirety of 
both this manual and the Optidrive Plus User Guide! 

Do not  install the serial cable next to power wiring. Contact us if you 
require 1m cable length assembly, LA502804 or custom lengths.

Check drive firmware version at P0-28. Must be 2.20 or higher. For 
firmware versions less than 3.0, the drive model number must end in -M 

Set drive parameters P2-26 = Modbus Address 1, P2-27 = 115.2kbps.

Indicator LEDs in front panel. For setup, troubleshooting and monitoring:

Power On Green LED

Fault Red LED. Check power supply, connect with savvy or 
contact us at drive.web for more information.

Ethernet Link Green LED indicates Ethernet connection.

Ethernet Activity Yellow LED-Data transmitted or received.

100BaseTX Green LED connection with 100Base-TX.

PoE Option 14 only, see page 19, product manual, HG502612

Four yellow LEDs  in smarty-o front panel indicate data 
received and transmitted. 

Port 1 displays Optidrive Plus serial link activity. 

Port 2 is i2i receiver-only with option 16 external encoder 
module or ModbusRTU Slave transceiver with option 17.

Protective Earth Do NOT use for 0V or control wiring. 
Observe local electrical codes and best wiring practices.
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HJ502441 smarty front label
Physical Dim.s & CutoutsBardac 40 Log Canoe Circle

Stevensville  MD 21666
(410) 604-3400 phone
(410) 604-3500 fax

info@bardac.com
www.bardac.com Ian Bardwell-Jonesissue 1 Bardac Confidential
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Reference Datum

Label Type 875

15 mil Clear VTP with 5 mil 3M #468 Adhesive

Three (3) Cut-outs

All Dimensions in mm ±0.1 mm

See attached drawing GA502441 for art and color information

Important Notes: 

Drawing is confidential for use in 

   creating labels for this order only.

Drawing is scaled 300% actual size.

All circles that appear, "white," 

   are no color (clear).

Background color to flood beyond 

   edges.

See attached drawing HJ502441 for 

   cutout dimensions.

Red color is 19 Fire Red.

Dark Gray is 29 Gray.

Background Gray is 27 Cool Gray.

99.00mm Ref.

Drawing No. Issue: Drawing Title: Drawn by: Property of:

GA502441 1 smarty front label art Ian Bardwell-Jones Bardac Corp.
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smarty Terminals and Layout
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smarty Flexible Analog & Digital I/O & ±10Vrefs
I/O Ratings including ±10Vrefs: Use shielded cable for runs over 30 meters.

Do not connect to any mains circuit. 
Fast transient over-Voltage 1kV per EN 61000-4-4.

I/AO  Terminals 13-16 and 19-22 +25V max, -13V min, 100kΩ 
input impedance. Any combinations; Bipolar Analog Out, Bipolar Analog 
In and/or Digital In.

I/DO  Terminals 23-24 and 27-32 +25V max, -0.6V min, 100kΩ 
input impedance. Any combinations; 24V Digital Out, Unipolar Analog In 
and/or Digital In. 

Analog Input Function Block
16 bit resolution. 
4-20mA Input: Connect a 100Ω resistor 
from the Input terminal to  a 0V terminal, 
set Scaling = 1.6V and Offset = -25%

Bipolar Analog Output Function Block
±10.5V, 10mA max output. 14 bit resolution. Enable “on the fly” 
with the Output Enable parameter. 

Digital Input Function Block
Selectable Ranges 5V, 12V & 24V.

Digital Output Function Block
+24V, 50mA max. Enable Source and/or Sink.  
Source drivers shut down in case of overheating or 
over-current. A warning triangle appears in the 
function block and its Source Status parameter 
indicates Fault. Connect Source Status to a 
fault  contingency system for critical applications. Click  
Source Status to reveal a Reset button. Find the 
Reset function block in the I/O (1) list set. Note! 
Resetting a Digital Output briefly resets ALL I/O!
Note! Sink circuits are NOT self-protecting. Digital outputs with Sink 
Enable MUST be connected to  a load that is inherently impedance 
protected, current limiting or fuse protected with a fast acting 0.1A fuse.
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Digital Input 
Range

Turn-On 
Threshold

Turn-Off  
Threshold

5V 2.5V 0.83V
12V 6V 2V
24V 12V 4V
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smarty Ethernet Networking & Programming
Before proceeding, it is important to have a basic 
understanding of Ethernet TCP/IP networks. Assigning an 
invalid or duplicate IP address will cause serious network 
malfunctions! smartys are all shipped with the same IP 
address, 10.189.189.189. Consult your company’s IT 
department for an appropriate, unique IP address.

Find useful networking information. Under the Help menu click on User 
Manual. Scroll down to the Basic Network Administration section. 

Set up Your Physical Ethernet Network - You Will Need:
A standard Category 5e cable with 8P8C/RJ-45 connectors on both ends 

for each drive.web  device and your computer.

For systems with more than one drive.web device, an Ethernet switch 
with ports for all drive.web devices and your computer.

Set up Your Computer - Get savvy

With free drive.web savvy software, easily program and 
monitor your smarty, perform data trending and create 
distributed control systems.

To download the latest  version of savvy go to 
www.driveweb.com and click on Get savvy.

Java Runtime Environment must be installed to run 
savvy. There is a link on the Get savvy page to download Java for free. 

If you do not have internet access, install savvy and Java from the 
Bardac Infodisk. Browse to the savvy link, off-line installation. 
Contact us for the files or Infodisk.

drive.web automation
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Get started with savvy
We strongly recommend you attend our free on-line training 
seminars. To register, e-mail training@driveweb.com or call.

Before proceeding with your systems designs it is very important to 
familiarize yourself  with savvy, the configuration software. 

We strongly recommend you read the User Manual and Getting 
Started Guides under the Help menu.   

Use Create Phantom  in the Directory menu to practice, explore 
all drive.web products and options and design and configure 
off-line. Design systems in Phantom devices and Export Data 
under the Directory menu for later use in live devices. Import 
Data into  phantoms to work off-line. 

Under the Directory menu, click on Discover All Local 
Devices.  If your smarty is powered up and on the same 
local network as your computer, an icon should appear.  

Discover drive.web devices anywhere on the internet 
unless they are protected by firewalls or other network 
security devices. Assign a public IP address or use a VPN. 
Under the Directory menu, click on Discover Device...  

If the icon at right appears with the red padlock and 
comms-fail indication, a network connection problem 
exists. Check connections, LEDs and that the smarty  IP 
address is within your computer’s Ethernet subnet mask.  

Warning! Changing a device IP address WILL disrupt its network 
connections! If a smarty is communicating with other devices or 
drives you must be prepared for system disruption and to remap 
connections in those devices when changing an IP address. In the File 
menu choose Utility > Remap Export File to remap a dw-system 
file with different IP address(es).
Under the File menu, click Administrate > Set IP 

Addresses for System.  Locate the serial number on the 
product  label of your smarty. Enter a unique IP address 
that  is within your computer’s subnet mask and click OK.  
A smarty icon should appear with IP address beneath.
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Get started with savvy continued...
If the icon above right appears with a question mark, the 

smarty-o is not communicating with the drive. Check the 
drive power and serial port settings. See page 6.

The smarty-o icon should depict the drive frame size when 
communicating properly with the drive.

Hover your cursor over any active object such as a device, 
function block, connection or parameter icon to instantly 
view information in the status bar at the window top 
margin and reveal the Hover Button.

Click a Hover Button or right-click in any icon to access the 
Contextual Menu.

In the smarty contextual menu, choose Change Name to 
name your smarty for easy identification. The Find 
Parameter... function locates and jumps to a parameter. 
Simply enter its number, name or partial name.

To Import or Export (load or save) configuration data to or 
from your smarty, use its contextual menu.

To Import or Export all configuration and connection data 
to or from all drive.web devices and phantoms in the 
directory use Directory menu.

Advanced Users: At the bottom of the Setup IP 
Addresses window, click the arrow next to 
Network Information to set  subnet mask, 
router, SMTP mail server and SNTP time 
server IP addresses. See the savvy user 
manual. Note! If the Network Information 
box is expanded, this network information 
will be set  in the device(s) whose IP 
address(es) are changed.

savvy views are hierarchical with the Directory view at top. Use the 
navigation arrows in the status bar to view the next higher level or go 
backward and forward through a series of views. Note that menus 
change as you navigate. 

savvy functionality may be limited if you do not have the required 
capability level or a device is locked with a password.
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Get started with savvy continued...

Click the smarty icon to view the Device Overview 
screen (Standard savvy, no SFD). Click the 
Function Block Engine icon or, if you have options 
04 , 17 to 19, 25, the Comms Server icon to view. 

In the Function Block Engine view (Standard savvy, no SFD), click the 
FBE menu and add function blocks in the order that you want them to 
be processed. Processing order is from left to right, then top to bottom.

Click on a function block to view its parameters and functional detail. 
Connect between parameters and to parameters in other drive.web 

devices over Ethernet. 
Under the File menu, choose New Viewer... and then Open Device 

Directory. With two viewer windows, click on a parameter, drag a 
connection and drop onto a destination parameter in the other viewer.   

Use parameter contextual menus to Get Info, Add to Dock, Copy, 
Connect to…, start or end connections, Re-name..., Re-scale… and 
add custom enumerations.

Click any blue connection block or arrow to jump views to the other end.
Use contextual menus in drive.web-over-Ethernet and 

function block engine-to-Optidrive Plus connections to 
Change Sample Period…. and prioritize connections.

Click on parameters to open the setter box. Adjust the 
value with convenient graphical buttons or keyboard 
entry. Also buttons for return to default or last state.

Most drive.web parameters use 16 bit words allowing raw decimal 
integer values 0 to 65535 or ±32767. These raw values are formatted, 
limited and scaled depending on the parameter.  Use Get Info or Re-
Scale to verify or change.

Very complex  function block configurations with numerous Ethernet 
connections may produce Timebase Overrun indications at the 
System function block and performance will be affected. Increase the 
smarty’s Timebase Setpoint with the System block’s contextual 
menu. Make a connection from the Program Status parameter to log 
these occurrences or provide warning signals.
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Upgrading savvy and smarty
Upgrade savvy with SFD Signal Flow Diagram. 
Upgrade smarty with software options. 
Process credit cards or Vouchers on-line or Coupons off-line. 

To upgrade savvy go to the Commerce menu, select Upgrade savvy, 
check the desired option and click OK.

To upgrade smarty, right-click on the smarty icon, choose Upgrade 
Device…, check the desired option and click OK.

Your selected options will appear in the Shopping Cart. Select your 
method of  payment.

To process Vouchers, choose Pay>Online Via Vouchers in the 
Shopping Cart. Enter each Voucher code on a separate line.

To process Coupons click Buy and forward the code to your drive.web 
distributor. When you receive your coupons go to the Commerce menu 
and choose Coupon Manager. Enter individual codes in the top box 
and click the Add button. Click Apply.

savvy-SFD Signal Flow Diagram Upgrade
With savvy-SFD, build systems graphically while 

creating live drawings that are stored in your smarty.  
Set borders with user attributes, drag and drop 

connections, zoom, pan, cross-reference and annotate 
multi-page drawings. 

Right-click in an empty area of the SFD to zoom, add a 
new function block or note or to paste a parameter for 
convenient viewing.

A filterable list of function blocks and connections is at 
the left of the Signal Flow Diagram showing 
program execution order from top down. The 
order in which function blocks are processed can 
greatly influence system performance and the function 
of logic engines. Change execution order by dragging 
function blocks up or down the list. In this picture, 
ENC1 Speed function block and its outgoing 
connection will be moved so that they are processed 
after ENC Phase Lock. 
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savvyPanel Operator Station
With savvyPanel, your computer, Apple® mobile digital device; iPad®, 

iPhone® and iPod Touch® become operator touch stations.
Operator station data is located in the drive.web devices so setup is easy. 
Editing and building savvyPanel systems requires savvy SFD upgrade.
savvyPanel dwOption-26 must be installed in drive.web devices to 

enable the full suite of  tiles. A limited set is available without the option. 
Find complete information on savvyPanel in the savvy User Manual.

Get savvyPanel Free from the App Store℠
When your iPad or iPhone is connected to the 

internet with WiFi you are connected live to  a 
real drive system in our plant in Maryland, USA.

Touch Roll Change button to reset roll length.
Enable all section switches.
Touch the Line Start button and watch the line 

accelerate, run and automatically slow to stop at 
the required length.

Touch Set Speed, Set Temp or Set Tension to 
open the setter and make changes.

Touch parameter name to get info.  
Touch page-link arrows to browse demo pages.
Drive the demo with savvy in your computer. In 

the File menu > Demo Mode, choose Discover 
Internet Demo Devices, then File > Open savvyPanel.

Three savvyPanel Page Types
Systems Page present with multiple savvyPanel systems discovered. 

A savvyPanel system may contain tiles from many devices. 
A drive.web device may contribute to only one savvyPanel system.
Touch the systems button,     or     , in the window bar to access the 

systems page from home page. Lock this button with home password.
Home Page is the first operator page in a savvyPanel System.

Access home page from any operator page with the home button,      . 
This may be locked with the home password.

Operator Pages show graphic, page-link and parameter tiles. 
Pages can be renamed. The name appears in the window title bar.
View zooms to show all tiles, so layout strongly affects appearance.
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Three savvyPanel Tile Types
Parameter Tiles. Touch a settable parameter to 

see its savvyPanel setter. Includes; slider, 
keypad, 1x, 10x increment, default & revert. 

A parameter is settable if it  is not  read-only and 
has no incoming drive.web connection.

Meter tiles; Digital Panel Meter, dial or bar 
meter. Unipolar or bipolar. Full-scale or percentage.

Indicator tiles. Variety of  colors. Shows on/off, true/false state.
Pushbutton tiles; colored momentary and lighted Start/Stop.
Multi-position Switch tiles for enumerated parameters.

Graphic Tiles - create diagrams with a variety of  process elements.
Page-Link Tiles - A graphic tile that is also a touch page-link. 

Function Blocks Enable savvyPanel Actions
Enumerated Parameter block in Utility group. Only custom 

enumerations appear in the setter and multi-position switch.
In the savvyPanel function block group:

Latch supports lighted Start-Stop pushbuttons. 
Setpoint & Monitor blocks control meter range and clamp 

the setter. Combination blocks support dual display meters.
savvyPanel Launch, Setup and Important Notes

See the savvy User manual for detailed instructions.
Launch savvyPanel from a command line or batch file. 
Limit operators to savvyPanel-only, specify start system & page.
Discover devices specifically by discovery file, automatically or 

filtered by Group and/or savvyPanel Name.
Operator’s Note: If communication with a drive.web device is 

interrupted, affected tiles indicate a yellow bar at top with an 
exclamation warning. The displayed value is not updated.

Important  Design Note: An over-range enumeration is required if 
misreading an out-of-range value could cause a hazard.
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Device Group
savvyPanel System
Example

Discover devices when savvy 
launches or by using the 
Directory menu. Discover by;  
group, savvyPanel system, 
Discovery file or all local devices 
automatically or by request.

Device Directory

Function Block Engine Standard savvy savvy-SFD
With standard savvy, the device 
overview screen gives access to 
Comms Server setup, Function 
Block Engine and native device 
functions where applicable. 
With savvy-SFD place function 
blocks graphically, use function 
block list to review and arrange 
execution order.

Function Block
View functional elements and 
signal paths in relation to 
parameters. Parameters show 
type, drive.web connections, 
read-only and not at default 
adornments.  

Add parameters of  interest to set, 
view, create trend graphs and 
export .csv files for spreadsheets. 
Save docks and open multiple 
docks in different viewer 
windows.

Parameter Dock

savvy overview

Right-click on parameter,
“Copy Parameter”

Navigate 
Up 

Arrow

Device 
Name

Right-click on parameter
“Add to Parameter Dock” 

Dock menu > Show Trend

Touch or Click

Touch or Click
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Systems Page

savvyPanel 
Systems

savvyPanel Password is not 
set in savvyPanel operator 
station. No savvyPanel 
data is shown.

savvyPanel overview
View all available 
savvyPanel systems. Assign 
a savvyPanel system in 
each device’s contextual 
menu, one per device. If  a 
savvyPanel password is set 
in the device, it must also be 
added in savvyPanel 
operator station software 
under the savvyPanel menu

Home Page
The master page for a 
savvyPanel system. Similar 
to operator pages except that 
it may be accessed from any 
operator page by pressing the 
home button. Graphic tiles 
can be page links.

Up to 256 possible. May be 
page-linked in any way. Set 
savvy preferences so that 
operators view a specific page 
at launch. Use this preference 
and the home password to 
restrict access to the home 
page and pages linked only 
from the home page. Provide 
links to the home page to 
bypass the home password. 
home password then only 
restricts access to the systems 
page.

Operator Pages

? Systems Button. 
Requires Home Password if  set.

Touch or Click 
Page-Link Home Button. 

Requires Home Password if  set.

Right-click in an empty 
grid location and, 
“Paste Parameter”. 
Choose desired graphic.

Touch or Click

?



smarty Option 06 Winder Control Library
Accurate speed calibration of all components in a winder system is essential 
before commissioning.

Diameter Calculator Block. An instance of this block is required for 
Taper Tension and Torque Compensator blocks. Associate a 
Diameter Calculator in those blocks. 

Taper Tension Function Block. A positive setpoint reduces web 
tension as the roll diameter increases. 

Torque Compensator Block. Set Forward/Reverse Line Direction 
friction compensation, Unwind/Rewind and Wind Forward/Wind 
Reverse modes. Friction and Inertia Compensator buttons set 
Stiction, Static Friction & more. 

smarty Option 11 Encoder Control Library
Speed Lock and Phase Lock require dual encoders option 42. ENC Cycle 
Calibrator DINx requires external encoder module option 40 or 42.

ENCx Linear Position Master block for linear system, output±327.67%

ENCx Cyclic Position Master block for cyclic system, output 0 to 100%

ENC Cycle Calibrator Automatically calibrate cycle length and zero.
ENC Cyclic Error Converter Convert ±50% output to 0 to 100%.

ENC Indexed Cyclic Position Enter total and requested indexes.

ENC Indexed Position Easy setup indexing at any starting location.

ENC Position Point Locate 64-bit positions by event or calculation. 

ENC Position Monitor Resolution from one encoder edge to full span.
ENC Speed Lock lock shafts with speed matching criteria.

ENC Phase Lock lock shafts with absolute shaft position criteria.

ENC Registration (Call for availability) Align to external event inputs.
Find Encoder Positioning Application Note, HG502932. Click Manuals 

and Software link at www.driveweb.com.
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smarty Option 11 Encoder Control Library continued...

Electronic Line Shaft Examples - Connect Output of ENC Speed 
Lock or ENC Phase Lock to the Feedback parameter in a PI block or 
similar. Connect the PI Output to Trim Input in a Trim  block (option 
05) or similar which controls the follower drive’s speed setpoint. Input 
speed or phase offsets at the Setpoint parameter in the PI block. 

smarty-o Internal Hardware Options 14, 16 
Option 14 Power over Ethernet (PoE)

Use with a PoE Injector or PoE Ethernet switch. Power your smarty and 
connected devices up to 5W max. without a separate power supply. Use 
with a 24VDC power supply for fail-safe power. 

Option 16 External Encoder Module i2i Receiver at Port 2
Intelligent  2-wire Interface receiver for External Encoder Module, option 
40 or 42. Unpolarized & isolated, connect at T7 and T8. 

smarty-o Comms Interfaces-Modbus & EIP/PCCC
Warning! Use of smarty-o comms interfaces 04, 17, 25 and bus-
sharing the ODP Port 1 may cause motors and machinery to power up 
with high Voltages or start or operate in an unexpected, dangerous or 
lethal way. It is essential that you are completely familiar with the 
Ethernet server protocol and all of the equipment and the system 
design you are working with before attempting to use this option. It is 
also essential that a risk assessment is conducted to identify hazards. 
Risks must be reduced to tolerable levels.
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smarty-o Comms Interfaces, Modbus and EIP/PCCC continued...
Modbus Function Codes FC 01-06 and 16 are supported.
ModbusRTU Master also supports Yaskawa Holding Register function. 
ModbusTCP/IP Slave Option 04 also supports Modbus FC 15.
Find information on Modbus specifications - modbus.org/specs.php
ModbusRTU networks support only one master device, transceivers are 

1/8 unit loads. 
Boolean values are 0 or 1. Non-zero values are Boolean true. 
Note! You cannot write or force parameters that are read-only or have 

incoming drive.web connections.

ModbusRTU Installation
Wiring Notes  Wiring should be twisted-pair. All wiring outside of the 

metal enclosure should be shielded cable with individually shielded 
twisted-pairs such as Belden 8163.  Typically the cable shield should be 
grounded only at  one end, near the signal destination, with a 360° 
ground clamp where the shield enters your metal enclosure. Separate 
wiring from RF noise sources and AC power cabling. 

A and B must share a twisted pair. Do NOT pair C with other signals.
EIA485 Common Reference is required. Do not confuse C with other 

common, ground or shield connections.  
Contact us for manual HG502436 if: A ModbusRTU device has no C, 

AND there is more than one slave. Trunk is over 150 meters.
Correct multipoint topology is daisy-chain or trunk with device at each 

end and additional devices on short stub branches. Star, ring, or 
extended branch topologies are NOT recommended.

Connect line termination between A and B at both physical ends of a 
ModbusRTU network, typically 150Ω, 0.5W or for networks with line 
polarization, 120Ω, 0.25W and 1nF, 10V cap in series. Do NOT provide 
line termination on any network with an Optidrive Plus. 
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A T3 T6 A or Data − D0 Inverting Pin
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C T5 T8 SC or Data 0V Common Common Reference



smarty-o ModbusRTU Master, Bus-Share Port 1.
Adding network devices may affect Optidrive Plus serial link performance.

ModbusRTU Comms Port 1. Comms Speed 
& Configuration are Read-Only, 115.2kbps 
and 8-N-1 to match Optidrive Plus.

Minimum Comms Silence. Idle on-the-wire time 
before a new request is sent. Some devices 
require longer than minimum 3.5 characters. 
Longer times decrease comms efficiency.

Bandwidth. The portion of the serial port bandwidth devoted to slave 
devices other than the Optidrive Plus with address 1.

Actual Polling Period, High, Medium and Low. Read-Only. Time 
required to  poll all parameters in all Modbus Data blocks with that 
priority. Period is directly affected by number of parameters, silence 
times and any errors or timeouts.

Comms Timeout. 10 to 30000ms, master or client waits for a reply before 
moving to the next Modbus Data block in the polling cycle.

Status. Any Last Error in Modbus Data blocks. Click to Reset all. 
Enable. Globally enable and disable all Modbus Data blocks. 

Modbus Data Blocks, Boolean, INT16, UINT16
Define the data point, register, discrete or coil and 

the slave or server device. Create up to 32 data 
blocks. Addresses can be changed dynamically.

Boolean block’s Value can be True(1) or False(0). 
INT16, 16-bit Integer, Value is decimal 0 to ±32767. 
UINT16, Unsigned 16-bit Integer, Value is 0 to 65535.
Modbus Address. Unique address, 1 to 247 of  each server device. 
PDU Address  identifies the parameter, coil, discrete or register number in 

your server to read and/or write to/from.  
Enable Dynamically disable block when unneeded to reduce polling periods. 
Last Error enumerates last error detected. Click to Reset.

drive.web automation

smarty-o HG502575Iss1.2
  www.driveweb.com !            Page 21/24

http://www.driveweb.com
http://www.driveweb.com


smarty-o ModbusRTU Master Bus-Sharing, Data Blocks cont’d...
Modbus Type. ModbusRTU function supported by your server. 
Priority Three levels. Round-robin scheduler processes all High priority 

data blocks plus one other every round. All Medium  priority blocks are 
processed, one per round, then first Low priority block. Following 
rounds process all Medium priority blocks again then next Low priority.

Value. Raw decimal that is read/written to/from the remote parameter.

smarty-o Comms Server Options 04, 17 and 25 
Click the Comms Server icon in the FBE or SFD view to configure.
Comms Server Indirect parameters are sequentially 

numbered. Enter any parameter numbers to read or 
write them all with one operation. Add more with 
Comms Server Indirect function blocks in the 
Utility list set. You can directly address any 
parameter. You are NOT required to use them.

Comms Watchdog function block, available in the Utility function block 
list group, can only be written via Modbus comms. Write non-zero value 
to Input to keep Output = OK

smarty-o Option 04, Modbus TCP/IP Slave/Server
smarty-o with option 04 supports up to five simultaneous masters. 

Modbus TCP Slave Port 502  is standard. Change to  match the master in 
the unusual case that it is non-standard. 

smarty-o Option 17, Port 2 ModbusRTU Slave/Server
ModbusRTU Slave Address, unique in network, 1 to 247.
ModbusRTU Slave Speed Choose any speed from 0.1 to 500.0kb/s.
ModbusRTU Slave Config, character framing, 1-8-Parity-Stop.

Parity type; N None, O Odd, E Even, S Space(0) or M Mark(1).
Number of  Stop bits; 1, 1.5 or 2.

ModbusRTU Slave Min Silence. Idle time before a response is 
transmitted. 1.75ms recommended by ModbusRTU standard for speeds 
19.2kb/s and above is inefficient and may be reduced for this and other 
devices. Enter 0 for minimum, 3.5 Characters. (3.5(1+8+P+S)/Speed)

ModbusRTU Comms Error shows last error. Click to Reset. 
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smarty Option 25 EIP/PCCC Server
Supports EIP/PCCC Typed-Write and Typed-Read functions.
See Appendix  B of the savvy User Manual for information, examples 

and drive.web parameter IDs mapping to PLC addresses.
Supports up to two simultaneous clients. 

smarty External Module Options 
30 & 31 High Voltage Digital I/O Isolator 

See separate product manual HG502622 for details.

Replace terminal block plugs T17-T24 or T25-T32.  

Two NO relay contacts up to 3A max with shared 
common 

Four AC Digital Inputs with shared common, 
optically isolated from smarty

Option 30 has 115VAC inputs, 31 has 230VAC inputs.

40 or 42 Intelligent External Encoder Module Choose only one.  

See separate product manual HG502613 for details. 

Requires Option 16. Port 2 Receive LED is lit  when 
module is connected.

Differential Incremental Receivers with 
markers, and fault detection 

±2V min. to ±24V max. 

A and B channels, 500kHz max. 

Z Markers, 6000RPM max. 

Two digital inputs, 50Hz max. repetition rate, lock 
event to encoder edge. Threshold 8.2VDC± 7%.

Convenient DIN rail mounting. Enclosure matches smarty. 
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40 or 42 Intelligent External Encoder Module continued...
i2i Intelligent 2-Wire Interface transmitter. Easy non-polarized connection 

transmits up to 500 feet on twisted pair wiring. 
Green, power and yellow, i2i transmit LEDs in front panel. 
Add only one option 45 or 46. Retransmits A & B channels.

40 External Single Incremental Encoder Module One encoder and 
5V, 200mA auto-reset fused power output.

42 External Dual Incremental Encoders Module Two encoders & two 
5V, 200mA auto-reset fused power outputs.

45 Encoder Retransmit EIA(RS)485 & 422 compliant.
46 Encoder Retransmit ±24V differential signal out.

drive.web Product Line Overview
dw210 smarty with optional dual serial ports, encoders.

dw215 smarty-yf7 Yaskawa F7 AC Drive Controller.

speedy  sp Adds drive.web power and Ethernet access to  a PL/X Digital 
DC drive. Add any software and Modbus comms options.

speedy485 Adds drive.web power, Ethernet and ModbusTCP to any 
ModbusRTU enabled device. Add any software options.

savvy-SFD Signal Flow Diagram Upgrade, see page 13.

savvyPanel Operator Touch Station App, see pages 13 to 17.

smarty & ALL drive.web products are designed & assembled in the U.S.A.

Get expert drive.web help. Call or email techsupport@driveweb.com

drive.web Training Courses
Free drive.web online interactive training seminars take about one hour. 

Specialized online and factory training sessions are also available.  

To register email training@driveweb.com or call.
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